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iS50 NIR Module

The optional Thermo Scientific iS50 NIR module offers convenient, reproducible diffuse 
reflection sampling with the Nicolet™ iS™50 spectrometer using the integrating sphere or a 
fiber optic accessory.

Figure 1. iS50 NIR Module

The iS50 NIR module provides these enhanced features:

• Integrated design

• Push button configuration

• Two sampling options, local (integrating sphere) and remote (fiber optic, optional)

• Up to two dedicated detectors

• Automated internal reference

• Standards wheel (contains 2%, 10%, 20%, 40%, and 80% glass filters and a polystyrene 
sample)

The iS50 NIR module mounts on the left side of the spectrometer.

Fiber Optic 
sampling area
(optional)

iS50 NIR module

Integrating sphere
sampling area

Thermo Scientific SabIR
diffuse reflection probe
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The optional fiber optic sampling area can be used with the Thermo Scientific SabIR diffuse 
reflection probe, or with probes from other manufactures if the probes have SMA connectors. 
For information about additional sampling modules for the Nicolet iS50 spectrometer, 
contact our sales representative in your area.

The optional ValPro Qualification software can be used with the standards wheel for 
qualifying the NIR module’s performance. Refer to your ValPro™ documentation details.

For general information about the NIR diffuse reflection technique including compatible 
samples, processing, searching and analyzing diffuse reflection spectra, please refer to the 
document or help topic titled “NIR Sampling.”

Conventions Used in This Manual

This manual uses these conventions for providing safety and other special information:

Contents

• Operating Precautions

• Specifications

• Compatible Software

• Integrating Sphere Sampling

• Fiber Optic Sampling

• Using the Optional SabIR Probe

• Using Fiber Optic Accessories from Other Manufacturers

• Maintenance

NOTICE    Be sure that all persons operating this system read the site and safety manual 
first.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.

Note  Contains helpful supplementary information.
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Operating Precautions

Before using the iS50 NIR module, read these operating precautions to avoid damaging your 
equipment.

Precautions for the integrating sphere:

• Do not pour liquids directly onto the integrating sphere.

• Do not use harsh detergents, chemicals or abrasives to clean the surface of the integrating 
sphere; these can damage the finish.

• Make sure your sample materials will not react with the sapphire crystal sampling 
window.

• Use solvents that do not react with sapphire crystals when cleaning the sampling window.

• Avoid scraping the sampling window with samples or sample containers.

• Protect the electrical port on the surface of the integrating sphere. If the connector is 
clogged or jammed, contact a Thermo Scientific service representative.

Precautions for fiber optic cables:

• Do not drop the cables or knock them against a hard surface.

• Do not bend the cables or tightly coil them. The radius of the coils for the SabIR probe 
should be at least 30 cm. For other fiber optic accessories, refer to their user guides.

• Avoid twisting the cables when attaching the connectors to the ports.

• Do not overtighten or use tools to tighten the connectors when attaching the cables to the 
ports.

• Do not touch the end of a fiber optic cable connector or use solvents to clean it.

• Keep a protective cap on each end of the cable when it is not in use.

Precautions for the SabIR™ probe:

• Do not drop the probe or knock it against a hard surface.

• Do not subject the probe to rapid or excessive changes in temperature.

• Wipe off spilled chemicals immediately.

• Make sure your sample material will not react with the sapphire sampling window.

• Do not allow hard materials (glass, metal, ceramic, etc.) to contact the sampling window.

Tip  Provides helpful information that can make a task easier.
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• Use solvents that do not react with sapphire crystals when cleaning the sampling window.

• Power off the instrument before connecting the SabIR probe.

• Make sure the probe is clean before you insert it into the holster.

• Do not use the probe by itself to measure liquids. When sampling liquids, use the 
transflectance adapter available for the probe.

Specifications
Table 1. Specifications for the integrating sphere sampling area

Table 2. Specifications for the optional fiber optic sampling area

The NIR module spectral range is dependent upon the spectrometer configuration. The table 
below shows the available configurations and their corresponding spectral ranges.

Table 3. NIR module available spectral ranges

Feature Specification

Crystal material Sapphire

Internal reference Diffuse gold

Detector Dedicated Indium Gallium Arsenide (InGaAs)

Feature Specification

Fiber optic connectors SMA type

Detector InGaAs

Probe (optional) Thermo Scientific SabIR diffuse reflection probe

SabIR probe internal reference Spectralon™

Source Beamsplitter Detector Spectral range

White light CaF2
a

aCalcium Fluoride

InGaAsb

bIndium Gallium Arsenide

12,000 - 3,800 cm-1

White light XT-KBrc

cExtended range Potassium Bromide

InGaAsb 11,000 - 3,800 cm-1

Note  The iS50 NIR module requires a CaF2 window installed in the external beam port 
on the left side of the spectrometer.
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Compatible Software
Table 4. Software compatible with the NIR module

Integrating Sphere Sampling

The integrating sphere is a fast and easy-to-use tool for diffuse reflection sampling of solids 
and powders. This section covers:

• Integrating Sphere Features

• Samples Compatible with the Integrating Sphere

• Your First Experiment

• Collecting Backgrounds with the Integrating Sphere

• Using a Dark Correction

• Sampling Accessories for the Integrating Sphere

Software Use for...

OMNIC™ Configuring the NIR workflow, including quantitative analysis and 
spectral search, and collecting and analyzing NIR spectra. For more 
information, see “Your First Experiment” in the “Integrating Sphere 
Sampling” section or the “Fiber Optic Sampling” section.

OMNIC Specta™ Analyzing unknowns. This software includes our unique 
multi-component search feature for identifying the spectra of 
mixtures, a 9,000 compound spectral database, and features for using 
your computer’s hard drive as a library. For more information, refer to 
the help system in OMNIC Specta software.

TQ Analyst™ Creating quantitative and classification methods that can be used with 
OMNIC or RESULT™ software. TQ Analyst software provides an 
extensive suite of chemometrics features you can use to identify raw 
materials, perform quantitative analysis, and take spectral 
measurements. For more information, refer to the help system in your 
TQ Analyst software.

RESULT Running integrating sphere or SabIR quantitative methods that have 
been transferred to any Thermo Scientific Antaris™ near-infrared 
analyzer that uses RESULT version 3.0 or higher. For information 
about adding TQ Analyst methods to a RESULT workflow, please 
refer to your RESULT Integration Software User Guide.

Note: Only methods created in TQ Analyst software version 8.4 or 
higher can be transferred from OMNIC to RESULT software.
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Integrating Sphere Features

The major features of the iS50 NIR module integrating sphere are highlighted below.

Figure 2. iS50 NIR Integrating sphere sampling area features

• Sampling window. Light from the spectrometer passes through this transparent sapphire 
window to the sample.

• Sample accessory holder. Mounts over the sampling window and holds Thermo 
Scientific sample cups and tablet holder accessories.

• Internal gold reference. Can be used to collect background spectra. When enabled, the 
reference automatically moves into the beam path during background data collection, and 
out of the beam path during sample collection.

• Touch Point. Automatically configures the spectrometer for integrating sphere sampling. 
The Touch Point LED (Light Emitting Diode) shows the status of the iS50 NIR module. 
The LED has three states described below.

Touch Point

Gold reference (inside)

Sample accessory holder

Sampling window

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the integrating sphere 
sampling window when the spectrometer is powered on and the Integrating Sphere beam 
path is selected.
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Figure 3. Integrating sphere status indicator states

Samples Compatible with the Integrating Sphere

The integrating sphere can be used to measure a wide variety of samples. Some examples are 
provided below. Samples may be measured directly or in clear glass or plastic containers.

Table 5. Samples compatible with the integrating sphere

LED status Meaning

On Ready for use

Off System is not configured for integrating sphere 
sampling

Blinking Optics are reconfiguring

Types Characteristics Examples

Solidsa

aUse enough sample to completely cover the integrating sphere window. Place abrasive solids in a clear glass or 
plastic container.

Must have a rough or 
diffuse surface

Coated textiles, paper, wood, polymers, 
and plastics (especially plastics that have 
a milky, opaque appearance)

Tabletsb

bMay be placed directly on the integrating sphere window or in one of the tablet holder accessories.

Must have a reflective 
surface

White or colored doses of aspirin, 
acetaminophen or other drugs

Powders, granules, 
pelletsc

cMay be measured in clear glass, flat-bottom vials, clear plastic bags, or in Thermo Scientific sample cups. Fill the 
sample cup to a depth of at least 5 mm. To improve reproducibility, fill the cup with the powder until it is 
overflowing and then level it with a spatula. If possible, use a closed sample cup and cover.

Particles can be any size, 
from fine to rough ground 
up to large pellets

Polyethylene, excipients, flour

Liquids, gelsd

dMust be measured in clear glass, flat-bottom vials or clear plastic bags. Do not use Thermo Scientific sample cups 
for liquids. If the liquid is clear, you can analyze it using the SabIR probe with a transflectance adapter. See Using 
the Optional SabIR Probe and Sampling Accessories for the SabIR Probe for more information.

Must be a suspension or 
opaque, or use a dip probe

Milk, colloidal suspensions, dispersed 
solids

NOTICE    

• Do not pour liquids directly onto the sampling area of the integrating sphere, 
especially the area around the electrical connector for the Sample Spinner accessory.

• Make sure your sample materials and cleaning solvents will not react with the 
sapphire sampling window. Refer to the “Cleaning the Integrating Sphere Sampling 
Window” section for more information.

• Avoid scraping the sampling window with samples or sample containers.
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A variety of accessories are available for fast, reproducible sampling of tablets, pellets, powders 
and gels. For more information, please refer to the “Sampling Accessories for the Integrating 
Sphere” section.

Sample thickness or the amount of sample should be taken into consideration when using the 
integrating sphere. If a solid sample is too thin or if there is not enough of a powder sample, 
you may encounter problems with the spectra.

Your First Experiment

This section explains how to configure your integrating sphere workflow and demonstrates 
how to use the integrating sphere to analyze a sample.

Configuring Your Integrating Sphere Workflow

The integrating sphere Touch Point has an associated user-configurable workflow that can 
define everything from background and sample collection to quantitative analysis and spectral 
search. You simply press the Touch Point to start the workflow. The Touch Point can also be 
used to respond to prompts in the software while the workflow is running.

 To configure your integrating sphere workflow

1. Start OMNIC software.

The OMNIC window is displayed. For information about the OMNIC window, choose 
Help > OMNIC Help Topics.

2. Choose the integrating sphere Touch Point button in the software to configure the 
instrument for integrating sphere sampling.

3. Choose the Touch Point Setup button in the software.

Touch Point Setup button

Integrating Sphere
Touch Point button
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A dialog box is displayed.

Notice that Sample Location (upper left pane) is set to NIRiSphere, and below that pane 
is a list of iS50 experiments for the integrating sphere. The selected experiment is 
highlighted and its associated settings are visible in the dialog box.

The Touch Point Setup dialog box provides commonly used settings that define how your 
integrating sphere data will be collected, displayed, measured and reported. Brief 
descriptions are provided below.

Table 6. iS50 integrating sphere Touch Point settings

Option Description

Measurement time Determines the duration of scanning for sample data 
collection.

Number of scans Shows the scans collected for the selected measurement time. 
Multiple scans are averaged.

Resolution Sets the spectral resolution of the data you collect. Typically 
16 cm-1 or 8 cm-1 is appropriate for most integrating sphere 
applications. The smaller the resolution value, the higher 
(better) is the resolution. The resolution value, along with the 
number of scans, affects the collection time.
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Final format Determines the Y-axis unit used for the collected data. 
Typically set to log(1/R) or %Reflectance for integrating 
sphere applications.

Preview data 
collection

Select this option if you want to collect and view (but not save) 
preliminary data before the start of a sample or background 
data collection. This lets you verify that your experimental 
conditions are correct before collecting the spectrum.

Region Determines the spectral range of the spectrometer that will be 
used to collect the data. The spectral range is defined by the 
type of source, beamsplitter and detector used. Near-IR is the 
only available Region option for the integrating sphere.

Max/Min Shows the default limits of the integrating sphere detector’s 
spectral range. The Max/Min limits can be reduced to 
eliminate spectral regions that provide no additional 
information about the sample.

Background handling Lets you specify when to collect a background spectrum to be 
used for ratioing sample spectra you collect. Collecting a 
background after a specified number of minutes is a good 
choice for many applications. You will be prompted to collect a 
background the very first time you collect a sample spectrum.

Note: The background type (internal or external) is defined on 
the Bench tab of the Experiment Setup dialog box. Choose the 
Experiment Setup button to open it. For more information, 
open OMNIC Help Topics and find the “Setting the NIR 
Background Type” topic.;reference:internal for integrating 
sphere

Analyze Measured 
Sample

Allows you to select and run analyses on the collected sample 
spectrum. The analysis results are attached to the spectrum 
and saved in the spectral (.spa or .spg) file. The following 
analyses are available:

• Quantify. Finds the concentrations of components in a 
sample spectrum. For more information, open OMNIC 
Help Topics and find the “Quantifying a Spectrum” topic.

To select the quantitative analysis method you want to use 
to quantify a spectrum, choose Analyze > Quant Setup.

Table 6. iS50 integrating sphere Touch Point settings

Option Description
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• Search. Identifies an unknown material by comparing the 
unknown sample spectrum with each reference spectrum 
in the selected libraries to find the spectra that most closely 
match the unknown. For more information, open 
OMNIC Help Topics and find the “Searching a Spectral 
Library” topic.

Use Analyze > Library Setup to select the reference 
libraries to be searched.

• QCheck. Compares spectra to determine their degree of 
similarity, expressed as a correlation value from 0.0 (no 
similarity) to 1.0 (the spectra are identical). For more 
information, open OMNIC Help Topics and search for 
the “Comparing Spectra with QCheck” topic.

Use Analyze > QCheck Setup to set up the comparison.

• Find Peaks. Identifies peak locations in a spectrum by 
finding peaks whose Y values exceed a specified threshold 
value. The peaks are labeled with their X values. For more 
information, open OMNIC Help Topics and search for 
the “Finding Peaks Above a Specified Height” topic.

• Threshold. The Y value above which peaks can be 
found.

• Sensitivity. Determines how readily shoulders on 
peaks and small peaks in the baseline will be found.

Auto Report Can be used to automatically display, print or save an auto 
report of the analysis results. For more information, open 
OMNIC Help Topics and find “Working with Auto Reports.”

• Preview. Displays the auto report after the analysis is 
completed.

• Print. Prints the auto report after the analysis is 
completed.

• Add to current notebook. Adds the report to the current 
report notebook. For more information, open OMNIC 
Help Topics and find “Adding a Report to a Notebook.”

Default experiment Shows the file name of the default experiment for the selected 
sample location. The default experiments are write protected 
to prevent them from being overwritten accidentally.

Table 6. iS50 integrating sphere Touch Point settings

Option Description
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4. Select an appropriate experiment in the “Experiments Using: NIRiSphere” pane.

5. Set the Touch Point Setup options as desired.

6. If you want to overwrite the default settings without overwriting the default experiment, 
choose Set Default.

7. Choose Save.

8. If you need to specify other experiment settings, choose Experiment Setup, set the 
options as desired, choose Save and then choose OK to close Experiment Setup. For more 
information, choose Help from Experiment Setup.

9. Choose OK to close Touch Point Setup.

Measuring a Sample with the Integrating Sphere

Before You Begin

• Power on the spectrometer and allow the instrument to stabilize for at least an hour (if the 
instrument has been powered off for more than 20 minutes).

• Make sure the sampling window is clean. Please refer to the “Cleaning the Integrating 
Sphere Sampling Window” section for instructions and recommended solvents.

• Have your sample material at hand. For the collection settings in the default workflow, we 
recommend that you choose one of the following items for your sample:

• 325 mg aspirin tablet, or

• A piece of white bond or other paper such as a business card, or

• A small clear glass or plastic container of sugar or other granular solid.

Note  Some settings appear in Experiment Setup and in Touch Point Setup. Setting 
these options in one location automatically changes them in the other.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the integrating sphere 
sampling window when the spectrometer is powered on and the Integrating Sphere beam 
path is selected.

NOTICE    

• Do not pour liquids directly onto the sampling area of the integrating sphere, 
especially the area around the electrical connector for the Sample Spinner.

• Make sure your sample materials and cleaning solvents will not react with the 
sapphire window. Refer to the “Cleaning the Integrating Sphere Sampling Window” 
section for more information.

• Avoid scraping the sampling window with samples or sample containers.
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Figure 4. Solid sample ready for measurement with the integrating sphere

1. Press the integrating sphere Touch Point to configure the instrument for integrating 
sphere sampling and load the default workflow.

A message may be displayed while the instrument collects scans to determine stability 
with the new configuration.

 To measure a tablet with the integrating sphere (watch video)

Integrating sphere 
Touch Point
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2. Wait until the stability test is completed, or choose OK to skip that test or Cancel to stop 
all instrument tests. When the stability test is completed, another message may be 
displayed while the instrument runs a performance test.

3. Wait until the performance test is completed and choose OK.

4. If your integrating sphere workflow is not configured, follow the steps in the 
“Configuring Your Integrating Sphere Workflow” section to configure it.

5. Press the integrating sphere Touch Point to start the workflow.

If the workflow is set up to collect a dark correction spectrum (that is, if Dark Correct is 
selected on the Bench tab in the Experiment Setup dialog box), a message asks you to 
prepare to collect a dark correction spectrum. Follow these steps to collect the correction 
spectrum:

a. Remove any sample from the integrating sphere and choose OK (or press the 
integrating sphere Touch Point) to collect the spectrum. See the “Using a Dark 
Correction” section for details.

When the spectrum is completed, a message asks whether to add it to an OMNIC 
spectral window.

b. Choose Yes or press the Touch Point. The dark correction spectrum is saved whether 
or not it is added to a window.

If the workflow is not set up to collect a dark correction spectrum, a message asks for a 
spectrum title.

6. Enter a title for your sample spectrum and choose OK or press the integrating sphere 
Touch Point.
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If the software has no appropriate background spectrum in memory and the workflow is 
set up to collect a background using the internal gold reference, the software begins 
collecting a background spectrum. You will hear the reference “click” in place, causing all 
of the light beam to reflect back into the integrating sphere. When the background is 
completed, you will hear the reference “click” open again. The background spectrum is 
added to the selected OMNIC spectral window and a message asks you to prepare for the 
sample collection.

7. Place the sample in the center of the integrating sphere sampling window. See the 
“Samples Compatible with the Integrating Sphere” section for more information.

8. Choose OK or press the Touch Point to collect the sample spectrum.

When the spectrum is completed, a message asks whether to add it to a window.

9. Choose Yes or press the Touch Point to add the spectrum to the selected window and 
complete the workflow.

If your workflow specifies an analysis such as quantify or search, those steps occur 
automatically. To see the analysis results, choose the “r” button to the left of the title box 
above the OMNIC spectral window.

The sample spectrum and its associated analysis results are stored in a virtual report. If 
your workflow is set up to preview or print auto reports, the report is displayed or printed 
on the default printer. Below is an example report showing a diffuse reflection spectrum 
of a business card taken with the iS50 NIR integrating sphere, followed by the results 
from a spectral search.

Note  If the workflow is configured to collect a background using an external 
reference, a message asks you to prepare for the background collection. Center the 
reference on the integrating sphere window and press the Touch Point to collect the 
spectrum. When the background measurement is completed, the spectrum is added 
to the selected window and a message asks you to prepare for the sample collection. 
See the “Backgrounds Taken with an External Reference” section for examples of 
materials that can be used as an external reference.
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Figure 5. Auto report showing a diffuse reflection spectrum of adhesive taken with the 
iS50 NIR module integrating sphere and the results from a spectral search

10. Remove the sample and clean the integrating sphere window.

Moisten a clean white paper napkin with isopropyl alcohol and use it to wipe the window. 
Dry the window with a clean napkin.

Collecting Backgrounds with the Integrating Sphere

A background is a reference spectrum that accounts for the unique optics of the sampling 
module and the instrument. Each sample spectrum is ratioed against a background so that the 
final spectrum is free of these features.

You can collect backgrounds using an internal or external reference or using no reference, as 
directed by the workflow you are running. The workflow will also direct how often to collect 
a background spectrum. The most recent background spectrum remains in memory and is 
compared against sample data until a new background spectrum is collected.

Backgrounds Taken with the Internal Reference

When the internal reference is used, a gold flag located underneath the integrating sphere 
window closes during background collection, causing all of the light beam to be reflected back 
into the integrating sphere. A typical background spectrum using the internal reference 
should resemble the following.
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Figure 6. Typical gold reference background spectrum taken with the iS50 integrating sphere

Backgrounds Taken with an External Reference

When the integrating sphere workflow is configured to collect a background using an external 
reference, the workflow prompts for a reference before background collection begins. Some 
examples of materials that can be used as an external background reference include:

• Diffuse gold

• Spectralon, which is a very diffuse substance with high reflectance

• Ceramic

Center the reference over the integrating sphere window and then respond to the prompt by 
choosing OK or pressing the integrating sphere Touch Point. Do not move the reference until 
the instrument has finished collecting the data.

Using a Dark Correction

When taking sample measurements with the integrating sphere or SabIR probe, a small 
amount of light is reflected off the sampling window and measured by the detector although it 
contains no additional information about the sample. We provide a way to measure and 
remove this information from the sample measurement so the reflections in the final spectrum 
are due solely to the sample.

We call the measurement a “dark correction spectrum.” To set up your workflow to collect a 
dark correction spectrum and automatically apply the correction to your sample data, choose 
Collect > Experiment Setup and then select the Bench tab. When Sample Compartment is set 
to NIR Integrating Sphere or NIR Fiber Optic, a Dark Correction parameter appears in the 
parameter list. Make sure Dark Correction is selected and save the experiment. For more 
information about the Dark Correction feature, open OMNIC Help Topics and search for 
the “Dark Correction” topic.

Tip  Once a material is selected for a background reference, make sure to use the same 
material each time you run the workflow.
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Sampling Accessories for the Integrating Sphere

Optional Thermo Scientific accessories for the integrating sphere are described in the table 
below, followed by additional information. To order an accessory, contact our local sales or 
service representative or see our contact information at the beginning of this document or 
help system.

Table 7. Optional Thermo Scientific accessories for the integrating sphere

This accessory… Does this…

Sample accessory holder Holds Thermo Scientific sample cups and tablet holder 
accessories.

The sample accessory holder attaches to the top of the 
iS50 NIR module. The kit includes two sample cup 
rings: a concentric (centering) ring and an eccentric 
(offset) ring. The concentric ring can be used to achieve 
consistent positioning with the sample cups and the 
sample accessory holder. The eccentric ring works with 
the sample accessory holder and the 5 cm sample cups to 
allow sampling over a wider area. Refer to the “Using the 
Sample Cups and Rings” section for more information.

5 cm open sample cups These come in packages of three sample cups. Each cup 
has a 4.78 mm low OH quartz window and can be used 
with the sample accessory holder and sample rings to 
measure powders. (The open sample cups are not 
recommended for liquids and gels.)

Sample cup rings
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Tablet holder kit Contains one universal tablet holder, a tablet holder ring, 
and two custom tablet holders. The tablet holder 
accessories fit in the sample accessory holder.

The universal tablet holder adjusts to fit snugly around a 
round tablet for consistent sampling. Please refer to the 
“Using the Universal Tablet Holder” section for more 
information.

The custom tablet holders can be cut to fit the exact 
dimensions of a tablet. The custom tablet holders require 
the tablet holder ring. See the “Using the Custom Tablet 
Holders” section for details. 

Viscous Liquid Sampler (VLS) Allows you to run transflection experiments with viscous 
liquids. The VLS fits in the sample accessory holder. For 
detailed information about the VLS, please refer to the 
document or topic with that title.

5 cm Sample Spinner Allows multi-point sampling for large particles such as 
pellets and grains. The Sample Spinner fits the 5 cm 
open sample cups. For detailed information about the 
Sample Spinner, please refer to the document or topic 
with that title.

Universal Tablet Holder

Custom Tablet Holder
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Using the Sample Accessory Holder

1. Insert the tab into the slot.

2. Lower the holder onto the NIR module (a magnet holds it in place).

1. Remove all sampling materials and accessories from the sample accessory holder.

2. Lift the accessory holder until it is perpendicular with the iS50 NIR module, and then 
carefully pull up on the accessory holder.

Using the Sample Cups and Rings

When used with the sample accessory holder and the sample cup rings, the sample cups allow 
you to run multiple collections of a powder in different sampling positions. The concentric 
ring opening is centered around the integrating sphere window and can be used with all sizes 
of the open and closed sample cups. The eccentric ring is offset around the integrating sphere 
window, and can be used with the 5 cm sample cup to conduct experiments covering all areas 
of the sample surface.

The sample cup rings have an indicator that can be aligned with indentations at 
60° increments around the circumference of the sample cups. When performing multiple data 
collections on a sample, you can use these indicators, along with the indentations in the 
sample cups, to rotate the sample to repeatable positions.

 To install the sample accessory holder (watch video)

 To remove the sample accessory holder (watch video)

Tab

Slot
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Figure 7. Repeatable positioning using sample cups and rings

 To fill the sample cups

1. Fill the cup with the powder until it is overflowing.

2. Use a flat edge to level off the top of the sample cup.

To install a ring, first 
install the sample 
accessory holder and 
then align the notch in 
the ring with the pin in 
the accessory holder.

Notch

Indicator

Eccentric ring Concentric ring

Spatula

Powder

Sample cup
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Using the Universal Tablet Holder

The universal tablet holder can be used along with the sample accessory holder to position 
round tablets of many sizes and thicknesses on the integrating sphere.

 To adjust the iris

1. Use your finger to gently turn the black ring to open the iris.

2. Place the tablet in the center of the tablet holder.

3. Adjust the black ring until the iris is almost touching the tablet (see the image below).

4. Use the silver ring to adjust the height of the iris so it is approximately at the center of the 
tablet’s width.

 To install the Universal Tablet Holder (watch video)

To install the universal 
tablet holder, align the 
notch with the pin.

Sample accessory holder

Universal tablet holder

Notch

Pin

Iris

Iris adjustment

Iris adjustment

Tablet

Height adjustment

Tablet
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5. Gently turn the black ring to close the iris around the tablet.

Using the Custom Tablet Holders

The custom tablet holders are designed to be used with the tablet holder ring, which has a lip 
around the inside opening (it does not have the position indicators like the sample cup rings).

The custom tablet holders contain a small hole to reference the center of the holder. The hole 
aligns with the center of the integrating sphere when the custom tablet holder is used with the 
sample accessory holder and tablet holder ring.

Use a utility knife or die to cut the tablet holder to the precise size of the tablet.

Fiber Optic Sampling

The optional fiber optic sampling area adds mirrors and ports to direct the near-infrared beam 
to a pair of input and output optical fibers for remote sampling with a fiber optic accessory. 
The ports are compatible with fiber optic sampling accessories that use various sampling 
techniques and have standard SMA connectors, including the optional Thermo Scientific 
SabIR diffuse reflection probe.

NOTICE    Do not overtighten the iris or you may damage it.

Tip  If your experiments require a great deal of precision, repeatability, and consistency, 
consider machining a metal tablet holder that fits the exact dimensions of the tablet and 
tablet holder ring.

Iris adjustment ring

Iris
Tablet

Centering hole

Custom tablet holder

Tablet holder ring
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Figure 8. iS50 NIR fiber optic sampling area features

The fiber optic sampling area includes these features:

• SMA type connectors.

• Dedicated InGaAs detector. The detector offers the same spectral range options as the 
integrating sphere. Please refer to the “Specifications” section for details.

• Touch Point. Automatically configures the spectrometer for NIR sampling with a fiber 
optic accessory. The Touch Point LED shows the status of the iS50 NIR module. The 
LED has three states described below.

Figure 9. Fiber optic status indicator states

LED status Meaning

On Ready for use

Off System is not configured for fiber optic sampling

Blinking Optics are reconfiguring

Fiber optic ports

Fiber optic Touch Point

SabIR probe 
(optional)
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Using the Optional SabIR Probe

The fiber optic sampling area is optimized for use with the Thermo Scientific SabIR diffuse 
reflection probe to provide easy, remote sampling of solids and powders.

Figure 10. Optional SabIR diffuse reflection probe

This section covers:

• SabIR Probe Features

• Connecting the Strain Relief Mechanism

• Connecting the SabIR Probe to the NIR Module

• Samples Compatible with the SabIR Probe

• Your First Experiment

• Collecting Backgrounds with the SabIR Probe

• Sampling Accessories for the SabIR Probe

• Disconnecting the SabIR Probe

• Storing the SabIR Probe
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SabIR Probe Features

The major features of the SabIR diffuse reflection probe are highlighted below.

Figure 11. SabIR probe features

• Probe and sheath. The stainless-steel shaft has graduated rings to indicate the sampling 
depth. The tip contains an angled sapphire sampling window. The probe start button 
can be used to start or continue sample collection from a remote location. Keep the 
sheath on the probe shaft when the probe is not connected to the iS50 NIR module.

• Holster. The holster is used for taking background collections with the internal reference. 
Make sure the probe is clean before you insert it into the holster to avoid contaminating 
the reference standard.

• Fiber optic cables. Cables are available in two- and three-meter lengths. The cable 
connectors are color-coded to correlate with the In and Out ports on the NIR module.

• Electrical connector. Attaches to the electrical port on the NIR module and is the power 
source to the probe.

• LED indicators. Three LEDs on the probe handle tell you the probe status. The LED 
states are described below.

(red, yellow, green)
LED Indicators

Probe start 
button

SheathHolster Electrical connector

Fiber optic cables

Internal reference 
(inside holster)
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Figure 12. SabIR probe LED states

Connecting the Strain Relief Mechanism

The NIR module includes a strain relief mechanism that prevents the SabIR fiber optic and 
electrical cables from bending excessively at the connectors. It is easiest to attach the strain 
relief to the spectrometer before you plug in the connectors for the SabIR probe.

 To attach the strain relief mechanism to the iS50 NIR module

1. Align the two pegs and the center thumbscrew on the end of the strain relief mechanism 
with the holes below the fiber optic connectors.

2. Hand tighten the thumbscrew until the surface of the strain relief mechanism presses 
firmly against the NIR module.

LED status Meaning

Green - steady

Green - blinking

Instrument is ready to begin collecting data.

Instrument is waiting for a response from a software 
prompt.

Yellow - steady Probe is collecting data (do not move the probe when 
the yellow light is on)

Red An error occurred in the software.

NOTICE    Make sure you use the strain relief with the SabIR probe to protect the optical 
fibers when the probe is used for remote sampling.

Thumbscrew

Strain relief 
mechanism
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Connecting the SabIR Probe to the NIR Module

1. Power off the instrument.

2. If the strain relief mechanism is not installed, follow the instructions in the “Connecting 
the Strain Relief Mechanism” section to install it.

3. Remove the cable cover from the strain relief mechanism by loosening the two 
thumbscrews.

4. Remove the sheath from the SabIR probe tip and insert the probe into the holster.

NOTICE    

• Do not drop the fiber optic cables or the probe or knock them against a hard surface.

• Do not bend the cables or touch the ends, and avoid twisting them when attaching 
the connectors to the ports or you may contaminate or damage the optical fibers.

• Power off the instrument before connecting the SabIR probe to avoid damaging the 
electronics.

• Do not use the probe in an explosive environment.

• Save all protective caps so they can be put back on the probe shaft and cable 
connectors and the fiber optic ports when they are not being used.

 To connect the SabIR probe to the iS50 NIR module (watch video)

NOTICE    Make sure you use the strain relief with the SabIR probe to protect the 
optical fibers when the probe is used for remote sampling.

Thumbscrews

Cable cover
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The probe is in position when you hear it “click” into place.

5. Remove the protective caps from the fiber optic cables and from the red and blue ports on 
the NIR module. Save the caps.

6. Plug the red connector from the SabIR probe into the red In port on the NIR module, 
and the blue connector into the blue Out port.

Hand-tighten the connectors until you feel a small amount of resistance, i.e., until they 
are finger tight.

NOTICE    Do not over tighten or use tools to tighten the connectors or you may damage 
the connectors on the probe or the NIR module.

Attach the cables to 
the correct ports to 
achieve consistent, 
repeatable results.

Do not discard the protective caps.
Replace the caps when the ports are not in use.

In port (red)

Out port (blue)

Electrical port
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7. Connect the electrical cable from the SabIR probe to the electrical port on the NIR 
module (see the previous image).

8. Gently maneuver the cables so the silver ring fits in the groove in the strain relief 
mechanism (see the previous image).

9. Replace the strain relief cover and secure it with the thumbscrews. Make sure the silver 
ring is completely hidden by the cover.

10. Power on the instrument.

If the instrument has been powered off for more than 20 minutes, allow it to stabilize for 
approximately one hour before collecting data.

NOTICE    

• Do not bend the cables when fitting them into the strain relief mechanism.

• Make sure the cables are resting in the groove and are not being compressed by the 
cable cover.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the SabIR sampling 
window when the SabIR probe is connected to the NIR module and the spectrometer is 
powered on and the Fiber Optic beam path is selected.
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Samples Compatible with the SabIR Probe

The SabIR probe can be used to measure powders and solids that have a rough surface. Some 
examples are provided below.

Table 8. Samples compatible with the SabIR probe

Sample thickness or the amount of sample should be taken into consideration when using the 
SabIR probe. If a solid sample is too thin or if there is not enough of a powder sample, you 
may encounter problems with the spectra.

Sampling Solids

When sampling a nonabrasive solid, hold the probe tip flush against the surface of the solid. 
Use enough sample to completely cover the probe window.

NOTICE    

• Make sure your sample materials and cleaning solvents will not react with the 
sapphire window. Refer to the “Cleaning the SabIR Probe” section more information.

• Do not allow hard materials (i.e., glass, metal, ceramic, etc.) to contact the sapphire 
sampling window.

• Do not use the probe by itself to measure liquids. When sampling liquids, use the 
transflectance adapter. Refer to the “Sampling Accessories for the SabIR Probe” 
section for more information.

Sample Type Examples

Powdersa

aMay be measured directly in small or large bins, or indirectly through clear packaging such as glass or plastic.

Powders, crystals, 
granules

Pharmaceutical precursors, sugars, grains, 
polymer beads

Solidsb

b May be measured directly or indirectly through a clear glass or plastic container.

Must have a rough or 
diffuse surface

Coated textiles, tablets, paper, wood, 
polymers, and plastics (especially plastics with 
a milky, opaque appearance).

Tip  For repeatable sampling with a homogeneous material, collect the data three times 
and hold the SabIR in the same position on the sample for each collection.

NOTICE    Place abrasive solids in a clear glass container or plastic bag before collecting 
data to avoid damaging the sapphire window.
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Figure 13. Sampling a nonabrasive solid with a diffuse reflection probe

You can also sample solids through clear packaging materials such as plastic bags, plastic wrap, 
or glass. Sampling through colored packaging materials may affect spectral data.

Sampling Powders

You can sample powders directly, or indirectly through clear packaging materials such as glass 
vials or plastic bags. When sampling a powder through packaging materials, follow the same 
sampling instructions used for sampling solids.

When sampling powders directly, make sure the sample is thick enough so the probe window 
is fully covered by the sample material but that enough of the sample material remains 
underneath the probe window to obtain an accurate reading.

Figure 14. Sampling a powder with a diffuse reflection probe

Use the depth indicator rings on the probe shaft to maintain a consistent insertion depth 
when collecting multiple samples.

Note  Polymeric materials such as plastics have spectral features which may affect analysis 
results.

Depth indicator rings
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Your First Experiment

This section explains how to configure your fiber optic workflow and demonstrates how to 
use the SabIR probe to analyze a sample.

Configuring Your Fiber Optic Workflow

The fiber optic Touch Point has an associated user-configurable workflow that can define 
everything from background and sample collection to quantitative analysis and spectral 
search. You simply press the Touch Point to start the workflow. The Touch Point can also be 
used to respond to prompts in the software while the workflow is running.

 To configure your fiber optic workflow

1. Start OMNIC software.

The OMNIC main window is displayed. For information about the OMNIC main 
window, choose Help > OMNIC Help Topics.

2. Choose the Fiber Optic Touch Point button in the software to configure the instrument 
for fiber optic sampling.

3. Choose the Touch Point Setup button in the software.

Touch Point Setup button

Fiber Optic Touch Point button



1 iS50 NIR Module

34 iS50 NIR Module User Guide Thermo Scientific

A dialog box is displayed.

Notice that Sample Location (upper left pane) is set to NIR Fiber, and below that pane is 
a list of iS50 experiments for the fiber optic sampling area. The selected experiment is 
highlighted and its associated settings are visible in the dialog box.

The Touch Point dialog box provides commonly used settings that define how your data 
will be collected, displayed, measured and reported. Except for the spectral range, all of 
the fiber optic default settings are the same as the default settings for the integrating 
sphere. For more information, see the “Configuring Your Integrating Sphere Workflow” 
section.

4. Select an appropriate experiment in the “Experiments Using: NIR Fiber” pane.

5. Set the Touch Point Setup options as desired.

6. If you want to overwrite the default settings without overwriting the default experiment, 
choose Set Default.

7. Choose Save.

8. If you need to specify other experiment settings, choose Experiment Setup, set the 
options as desired, choose Save and then choose OK to close Experiment Setup. For more 
information, choose Help from Experiment Setup.



 1 iS50 NIR Module

Thermo Scientific iS50 NIR Module User Guide 35

9. Choose OK to close the Touch Point Setup dialog box.

Measuring a Sample with the SabIR Probe

Before You Begin

• Power on the spectrometer and allow the instrument to stabilize for at least an hour (if the 
instrument has been powered off for more than 20 minutes).

• Make sure the probe window is clean. Refer to the “Cleaning the SabIR Probe” section for 
instructions and recommended solvents.

• Have your sample material at hand. For the collection settings in the default workflow, 
choose one of the following items for your sample:

• a piece of fabric, or

• A small clear glass or plastic container filled with sugar or another granular solid (we 
use polymer beads for this demonstration).

Figure 15. Sample ready for measurement with the SabIR probe

Note  Some settings appear in Experiment Setup and Touch Point Setup. Setting these 
options in one location automatically changes them in the other.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the SabIR sampling 
window when the SabIR probe is connected to the NIR module and the spectrometer is 
powered on and the Fiber Optic beam path is selected.
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1. Press the fiber optic Touch Point to configure the instrument for fiber optic sampling.

A message may be displayed while the instrument collects scans to determine instrument 
stability with the new configuration.

2. Wait until the stability test is completed, or choose OK or Cancel to skip the test.

3. If your fiber optic workflow is not configured, follow the steps in the “Configuring Your 
Fiber Optic Workflow” section to configure it.

4. Press the fiber optic Touch Point to start the workflow.

If the workflow is set up to collect a dark correction spectrum (that is, if Dark Correct is 
selected on the Bench tab in Experiment Setup), a message asks you to prepare to collect a 
dark correction spectrum. Follow these steps to collect the correction spectrum:

a. Remove the SabIR probe from the holster (do not press the probe start button).

b. Point the probe tip upward (not directed at any person) and then press and release the 
button on the probe handle (or press the fiber optic Touch Point on the instrument) 
to collect the spectrum. The LED on the probe handle changes from green to yellow 
when the probe starts collecting data. Keep the probe still during the measurement.

When the spectrum is completed, a message asks whether to add it to an OMNIC 
spectral window.

c. Choose Yes or press the Touch Point. The spectrum is saved whether or not it is 
added to a window.

d. Insert the probe shaft into the holster and press on the handle until you hear the 
probe “click” into place.

 To measure a sample with the Thermo Scientific SabIR probe (watch video)

Fiber Optic Touch Point
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If the workflow is not set up to collect a dark correction spectrum, a message asks for a 
spectrum title.

5. Enter a title for your sample spectrum and choose OK or press the fiber optic Touch 
Point or the probe start button.

If the software has no appropriate background spectrum in memory and the workflow is 
set up to collect a background using the internal reference, the software begins collecting 
a background spectrum from the Spectralon reference mounted in the holster. The 
background spectrum is added to the selected OMNIC spectral window and a message 
asks you to prepare for the sample collection. The green LED on the probe handle should 
be on.

6. Remove the probe from the holster (do not press the probe start button) and dip the tip 
in the sample so the window is completely covered. (There must be a thick layer of sample 
below the window to get an accurate reading.)

If the sample is in a container, hold the probe tip flush against the container surface. Use 
enough sample to completely cover the probe window.

Note  If the workflow is configured to collect a background using an external 
reference, a message asks you to prepare for the background collection. Gently hold 
the probe tip against the reference material and then press and release the probe start 
button (or press the fiber optic Touch Point) to start the measurement. When the 
background measurement is completed, the spectrum is added to the selected window 
and a message asks you to prepare for the sample collection. See the “Backgrounds 
Taken with an External Reference” section for examples of materials that can be used 
as an external reference.
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Figure 16. Powder sample ready for measurement with a diffuse reflection probe

For more information, refer to the “Sampling Solids” and “Sampling Powders” sections.

7. When the probe is in position, press and release the button on the probe handle (or press 
the fiber optic Touch Point) to collect the sample data.

Do not move the probe until the yellow light on the probe handle has turned off. When 
the spectrum is completed, a message asks whether to add it to a window.

8. Choose Yes or press the probe button or the fiber optic Touch Point to add the spectrum 
to the selected window and complete the workflow.

If your workflow specifies an analysis such as quantify or search, those steps occur 
automatically. To see the analysis results, choose the “r” button to the left of the title box 
above the spectral window.

The sample spectrum and any analysis results that were run on the data are stored in a 
virtual auto report. If your workflow is set up to preview or print auto reports, the report 
is displayed or printed on the default printer. Below is an example report showing a 
diffuse reflection spectrum of a polymer taken with the iS50 NIR module and SabIR 
probe.
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Figure 17. Auto report showing a diffuse reflection spectrum of a polymer taken with the 
iS50 NIR module and Thermo Scientific SabIR probe

9. Clean the probe tip.

Pour a small amount of cleaning solution (one part isopropyl alcohol with nine parts 
water) onto a soft cloth and gently rub the cloth on the probe shaft.

Using an eye-dropper, place a small amount of the cleaning solution on a clean piece of 
lens paper and then gently rub the paper on the optical window.

10. Insert the shaft into the holster until you hear it “click” in place.

Collecting Backgrounds with the SabIR Probe

A background is a reference spectrum that accounts for the unique optics of the sampling 
accessory and the instrument. Each sample spectrum is ratioed against a background so that 
the final spectrum is free of these features.

You can collect a background with the SabIR probe using the internal Spectralon reference or 
an external reference. The workflow should indicate which kind of reference should be used. 
The workflow will also direct how often to collect a background spectrum. The most recent 
background spectrum remains in memory and is compared against sample data until a new 
background spectrum is collected.

The “NIR Sampling” section contains suggestions if a background spectrum is atypical from 
previously collected background spectra.

Backgrounds Taken with the Internal Reference

The SabIR probe holster contains a Spectralon reference that can be used for collecting 
backgrounds. Spectralon is a very diffuse substance with high reflectance, but it is a soft, 
porous material that must be handled carefully. It can be cleaned if it becomes dirty. Please 
refer to the “Cleaning the Spectralon Background Reference” section for instructions on how 
to handle and clean the reference.
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The instrument automatically detects when the probe is properly inserted in the holster and 
the software can collect a background automatically without any operator prompts. While the 
instrument is collecting data, the yellow indicator light on the probe handle will be on. Do 
not remove the probe from the holster until the yellow light turns off.

A typical background spectrum using the Spectralon reference should resemble the following.

Figure 18. Typical Spectralon background spectrum taken with the iS50 NIR module and 
Thermo Scientific SabIR probe

Backgrounds Taken with an External Reference

When the fiber optic workflow is configured to collect a background using an external 
reference, the workflow prompts for a reference before background collection begins. Some 
examples of materials that can be used as an external background reference include:

• Spectralon

• Diffuse gold

• Ceramic or sintered polytef plate (solids)

• Barium sulfate, polytetrafluoroethylene (powders)

Hold the probe to the reference material if the reference is a solid (or dip the probe in the 
reference if it is a powder) and then press and release the button on the probe handle (or press 
the fiber optic Touch Point) to start collecting the data. While the instrument is collecting 
data, the yellow indicator light on the probe handle will be on. Do not move the probe until 
the yellow light turns off.

NOTICE    Make sure the probe sheath and window are clean before you insert the probe 
into the holster.

Tip  Once a material is selected for a background reference, make sure to use the same 
material each time you run the workflow.
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Sampling Accessories for the SabIR Probe

Optional Thermo Scientific accessories for the SabIR probe are described briefly below. To 
order an accessory, contact our local sales or service representative or see our contact 
information at the beginning of this document or help system.

Table 9. Optional Thermo Scientific accessories for the SabIR probe

This accessory… Does this…

SabIR Transflectance Adapter

SabIR probe and transflectance adapter 
used to measure a liquid sample

Slides on the SabIR probe shaft and allows 
you to analyze liquids using the transflectance 
sampling technique. For detailed information 
about the SabIR Transflectance Adapter, see 
the document or help topic with that title.
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Disconnecting the SabIR Probe

It is not necessary to disconnect the SabIR probe from the iS50 NIR module after each use. 
However, if you are not planning to use the probe for a long period of time, or if you need to 
remove it to attach a different accessory, follow these steps to disconnect the probe.

Probe stand

SabIR probe properly fitted in probe stand

Secures the SabIR probe for repeatable 
measurements where the tip angle and 
pathlength are important such as 
measurements with an external standard.

NOTICE    Power off the instrument before you disconnect the SabIR probe to avoid 
damaging the instrument’s electronics.
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1. Power off the instrument.

2. Insert the SabIR probe into the holster to avoid causing strain on the fiber optic cables 
from the weight of the probe.

1. Remove the strain relief cable cover by loosening the two captive thumbscrews.

2. Gently remove the cables from the groove in the strain relief base. (It is not necessary to 
remove the strain relief base.)

3. Disconnect the SabIR fiber optic cables from the ports (see the previous image).

4. Disconnect the SabIR electrical cable (see the previous image).

5. Replace the sheath on the probe shaft.

6. Replace the protective caps on the ends of the cables and the fiber optic ports.

7. Replace the strain relief cable cover.

 To disconnect the Thermo Scientific SabIR probe (watch video)

NOTICE    To avoid contaminating the internal reference, make sure the probe shaft 
and tip are clean before you insert the probe into the holster.

NOTICE    

• Do not bend the fiber optic cables or touch the ends, and avoid twisting them 
when detaching the connectors from the ports or you may contaminate or 
damage the optical fibers.

• Do not tightly coil the cables. The radius of the coils for the SabIR probe should 
be at least 30 cm.

Thumbscrews

Cable cover

SabIR electrical 
connector

Fiber optic ports

Strain relief base
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Storing the SabIR Probe

Store the SabIR probe in a dust-free environment such as a cabinet or its original shipping 
box.

Using Fiber Optic Accessories from Other Manufacturers

This section covers:

• Connecting a Fiber Optic Sampling Accessory

• Collecting Data

Connecting a Fiber Optic Sampling Accessory

 To connect a fiber optic sampling accessory to the iS50 NIR module

1. Remove any protective caps from the sampling accessory connectors.

Save the caps so they can be put back onto the accessory before it is stored.

2. Remove the protective caps from the In and Out fiber optic ports on the iS50 NIR 
module. Save the caps.

NOTICE    

• Do not bend the fiber optic cables or tightly coil them to avoid damaging the optical 
fibers. The radius of the coils for the SabIR probe should be at least 30 cm.

• Place the sheath on the probe shaft and the protective caps on the fiber optic cable 
connectors and the ports on the iS50 NIR module when they are not being used.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the fiber optic ports, or 
the fiber optic cables when they are connected to the ports, when the spectrometer is 
powered on and the Fiber Optic beam path is selected.
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3. Connect the SMA connector from your sampling accessory to each fiber optic port.

The near-infrared beam travels out the blue “out” port and into the fiber optic accessory. 
The light leaves the accessory and travels back into the module through the red “in” port. 
Use the color coding to assist you in consistently connecting the cables on your sampling 
accessory to the same ports on the module.

4. Hand-tighten the connectors until you feel a small amount of resistance, that is, until 
they are finger tight.

Collecting Data

Select a background material and sample that is compatible with your fiber optic accessory. 
Refer to the documentation that came with the accessory for information about compatible 
samples.

To collect the data, follow the steps in the “Your First Experiment” section using the fiber 
optic Touch Point or the software to continue to the next step. Do not move the sampling 
accessory until the instrument has completed collecting data.

Tip  It is important to consistently attach the fiber optic cables to the same ports when 
connecting sampling accessories. If there are differences between the fiber optic 
cables, and they are not always attached to the same ports, your data may be affected.

NOTICE    Do not over tighten the connectors or use tools to tighten them or you may 
damage the connectors on the accessory or the iS50 NIR module.

Fiber optic ports

Electrical connector
(for Thermo Scientific 
SabIR probe only)
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Maintenance

This section describes maintenance routines that you can perform on the iS50 NIR module to 
keep it running efficiently. This section covers:

• Cleaning the NIR Module Housing

• Cleaning the Integrating Sphere Sampling Window

• Cleaning Integrating Sphere Sampling Accessories

• Cleaning the SabIR Probe

• Cleaning the Spectralon Background Reference

Cleaning the NIR Module Housing

Use a damp (not wet), soft cloth and a mild soap to clean the integrating sphere cover and 
other metal parts, including the sample accessory holder. Dry them with a clean cloth.

Figure 19. Sample accessory holder

NOTICE    

• Do not pour liquids directly onto the sampling area of the integrating sphere, 
especially the area around the electrical port for the Sample Spinner.

• Do not use harsh detergents, chemicals or abrasives to clean the surface of the 
integrating sphere; these can damage the finish.

Sample accessory holder

Integrating sphere cover
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Cleaning the Integrating Sphere Sampling Window

 Cleaning the integrating sphere sampling window

1. Remove any sample, sample cup or accessory from the integrating sphere.

2. If the sample came in contact with the sampling window, gently clean the window with a 
clean, white paper napkin or cotton ball moistened with methanol, ethanol, isopropyl 
alcohol or water.

3. Dry the window with a clean napkin or cotton ball. Avoid materials that have been 
treated with aloe or other additives.

Cleaning Integrating Sphere Sampling Accessories

NOTICE    

• The cleaning fluid should be at or close to room temperature (or the temperature of 
the previous sample). Applying extremely hot or cold liquids to the sampling window 
may crack it.

• Some chemicals including acetone, chlorine, fluorine, and amyl alcohol can attack the 
epoxy seal around the sampling window. Do not allow these chemicals to come into 
contact with the window.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the integrating sphere 
sampling window when the spectrometer is powered on and the Integrating Sphere beam 
path is selected.

Tip  

• Chemical wipes such as Kimwipes™ are not recommended for cleaning the integrating 
sphere sampling window as embedded clays can make these slightly abrasive.

• Use of soaps or other surfactants for cleaning the sampling window is discouraged as 
these can leave a residue bound to the window surface.

To clean this accessory… Do this…

Sample cups Use a mild soap solution and then rinse with 
distilled water. Dry them with a jet of clean air 
or a non-abrasive cloth or paper napkin.

Notice
Do not use harsh solvents to clean the sample 
cups or you may damage them.
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Custom tablet holder Use a mild soap solution and then rinse with 
distilled water. Dry them with a jet of clean air 
or allow to air dry.

Notice
Do not use harsh solvents to clean the custom 
tablet holders or you may damage them.

Sample rings Use a dry, soft cloth or dampen it with 
isopropyl alcohol, distilled water, or a mild 
soap solution. Dry them with a clean cloth or 
allow to air dry.

Notice
Do not use harsh solvents to clean the sample 
rings or you may damage them.

Universal tablet holder Use a jet of clean air to remove any particles. If 
this is not sufficient, then gently rub the tablet 
holder with a cloth dampened with isopropyl 
alcohol and let it air dry.

Notice

• Do not use water to clean the universal 
tablet holder or it may rust.

• The iris is delicate; handle it gently.
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Cleaning the SabIR Probe

If the tip or shaft of the SabIR probe becomes dirty or contaminated with sample or other 
material, prepare a cleaning solution of one part isopropyl alcohol and nine parts water in a 
clean container and follow these instructions.

1. Remove the SabIR probe from the holster.

2. Pour a small amount of the cleaning solution onto a soft cloth and use it to gently clean 
the probe shaft. Allow the shaft to air dry.

3. Using an eye-dropper, place a small amount of the cleaning solution on a fresh piece of 
lens paper.

4. Gently rub the lens paper on the optical window for 10 to 20 seconds.

Allow the window to air dry for at least two minutes.

NOTICE    

• The cleaning fluid should be at or close to room temperature (or the temperature of 
the previous sample). Applying extremely hot or cold liquids may crack the sapphire 
sampling window.

• Some chemicals including acetone, chlorine, fluorine and amyl alcohol can attack the 
epoxy seal around the sapphire window. Do not allow these chemicals to come into 
contact with the window.

CAUTION  Avoid eye hazard. Do not stare at the beam that exits the SabIR sampling 
window when the SabIR probe is connected to the NIR module and the spectrometer is 
powered on and the Fiber Optic beam path is selected.

 To clean the Thermo Scientific SabIR probe (watch video)

Tip  

• Chemical wipes such as Kimwipes are not recommended for cleaning the SabIR probe 
sampling window as embedded clays can make these slightly abrasive.

• Use of soaps or other surfactants for cleaning the window is discouraged as these can 
leave a residue bound to the window surface.
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Cleaning the Spectralon Background Reference

Spectralon is an optical standard and should be handled with care. Keep the Spectralon 
reference in the SabIR probe holster at all times unless you need to clean or replace it.

 To clean the Spectralon reference

1. Put on a pair of clean gloves or finger cots.

2. Remove the SabIR probe from the holster and place it securely on a table.

3. Firmly grasp both sides of the reference holder with your thumb and forefinger and pull it 
out of the holster.

Figure 20. Removing the Spectralon reference

4. Clean the Spectralon surface with an air brush, using clean, dry air or nitrogen.

5. If this is insufficient, gently sand the surface with a 220-240 grit waterproof emery cloth.

6. If the surface is still not sufficiently clean, sand it under running water with a 220-240 
grit waterproof emery cloth until water beads and immediately runs off the surface. Dry 
the surface with a jet of clean, dry air or nitrogen, or allow the material to air dry.

If the background quality does not improve after thoroughly cleaning the Spectralon 
reference, the reference may need to be replaced. Contact our sales or service representative in 
your area for more information.

NOTICE    Avoid touching the surface of the Spectralon reference. Dirt and oils from your 
fingers can leave residue which will affect background spectra quality.

Remove the SabIR probe 
from the holster before 
you attempt to remove 
the reference holder.
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